AASHTOWare Load Rating Tool

for Automated Permitting
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Types of Loads

 Legal Loads |
« Divisible Over Legal Loads - Annual Permits
» Indivisible Over Legal Loads - Smgle rip Permits
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Bridge Design and Rating Loads

8,000 Ibs. 32,000 Ibs. 32,000 Ibs.

Ler | |

V' =Variable spacing — 14 feet to 30 feet inclusive.
Use spacing that produces maximum stresses.




ITD Over-legal Permitting Journey

Since we built bridge to 1990’s:
* Check heavy trucks over trouble bridges.




ITD Over-legal Permitting Journey

1990’s to 2021 - DMV screens by factor to determine which
permits need bridge analysis.

Weekly Average 4 years ago:

« 200 permits.

« 20 w/bridge analysis.

« 4 over 250k.

« Around 160 models run.

« Bridge Hours 60-80 a week.
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ITD Over-legal Permitting Journey
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2021- Current. Full bridge analysis and self issue permits takes about 5 minutes.

Current weekly average:

« 450 permits/week

« 48 w/bridge requirements
* 9 over 250k

* Only around 140 per week by bridge
Bridge hours 20-30 hours.
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Outline

|daho Permit Background

Automated Permitting Types

BrR Rating Tool
» Organizing the Files
» Optimizing the Program
* Managing the Data

|daho Permit Process



Routing or Rating

Pennsylvania
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Routing or Rating
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Routing or Rating
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Rule Based
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ROUTE CAPACITY MAP

BASIC ALLOWABLE UNIT WEIGHT

SINGLE AXLE

TWO-AXLE TANDEM
THREE-AXLE TRIDEM

33,000 LES 30,000 LBS
56,000 LBS 51,500 LBS
70,500 LBS 64,500 LBS

27,000 LBS 25,500 LES
46,000 LBES 43,500 LES
57,500 LBS 54,500 LBS

129 kip Routes

24,000 LES 22,500 LBS
41,000 LES 38,000 LBS
51,500 LBS 43,000 LBS

ROUTE CAPACITY MAP

EUASIC ALLDAWARLE UNIT WENHT

BINGLE AXLE
TWO-AXLE TANDEM 56,000 LBS

3340085 30,000 LES HowLEE 38500 LEE

81,508 LBS 46000 LES 43,980 LBS
THREE-AXLE TRIDEM 70,500 L85 64,500 LBS £7.500 LES 54,300 LB

24000 LES

41,080 LBS

& 51,300 LBS

200 LS
4,000 LBS
000 LBS




Truck Factors / Bridge Factors

 Quick screening tool for Bridge Capacity and Truck Loads
« Combines axle weights and spacing

At ITD the truck factor is based on Federal Formula B

fn

w=5{lﬂ(

L12n 4+ -?-ﬁ)

n—1

e W = the maximum weight in pounds that can be carried on a group of two or more axles to the nearest 500 pounds (230 kg).
« /= spacing in feet between the outer axles of any two or more consecutive axles.
e n = number of axles being considered.

« Factor developed for all axle groupings use highest



NOTE: INDICATED CONCENTRATIONS ARE WHEEL
LOADS IN KIPS OR AXLE LOADS IN TONS.

Bridge Factors 1 M e

Factor 580

8.100
5.450
9.450

Bridge Factor is based on
Rating Factors for Legal trucks

TYPE 352 UNIT

H5-20 ruc u Fastener Resistance WEIGHT = 39.50 TONS

Idaho-Type 3 ruc u Fastener Resistance

|daho-Type 352 Tuc ir. . Flexural - Steel Strength - Factor 5 52

ldaho-Type 3-3 ruc ir. . Flexural - Steel Strength

Idaho-121k ruc X ir. . Flexural - Steel Strength

CALTRANS P13 ruc ir. . Flexural - 5teel Strength

8.750
8.750

4.500
8.750

2.04 * 580 = 1183 Truck Factors

2.10 * 552 = 1159
2.04 * 494 = 1007

TYPE 3-3 UNIT
WEIGHT = 39.50 TONS

Bridge Factor is 1007 Factor 494

7.88

450
7.08




Outline

|daho Permit Background

Automated Permitting Types

BrR Rating Tool
» Organizing the Data
» Optimizing the Program
* Managing the Data

Ildaho Permit Process



History of Load Rating Tool

« AASHTOWare BrR

* Too slow for permitting - ratings take 5+ minu

 Loa

- Began upgrade to BrR 10 years agc '

d Rating Tool

ratings / second

» First included in 6.8.2 with limited capabilities

e 7.2 includes LRFR




Know Your Inventory

 Bridges not Load Rated in AASHTOWare BrR
* Tables
* Rules
* Excel sheets

» Engineering Judgement (no plans)

. Brldges Load Rated in AASHTOWare Br
Load Rating Tool
« LFD Member Alternativ
 LRFR
- 3D FEM

« Check out to run .

Of our bridges only 66 out of 1800 not using the load rating tool



Tables, Rules, Excel, Engineering Judgement

225 to <250 Slow to 45 mph

250 to <275 Slow to 5 mph
120 250 Slow to 5 mph
275 to <325 e

Slow to 5 mph
Only vehicle on the bridge in the direction of travel (centered in travelway)
Trailer axles must be a minimum of 16 feet wide
Slow to 5 mph
400 to <600 Only vehicle on the bridge in the direction of travel (centered in travelway)
754 791 Only one lane of traffic allowed in the opposing direction
m Trailer axles must be a minimum of 16 feet wide
498
- -




= ﬁ Users
- &b All Users
-ﬂ Administrators
- &b Design Engineers
- &4k Managers

2 -2k Rating Engineers
Load Rating Tool Rules iR
B[ Access Privileges
- (& Access Rights
- (& Bridge Administration
- (& Bridge Check-Out
ﬁ Bridge Description
- (3 Bridge Description Custom Agency Fiels
- EBridge Exchange
- (&) Bridge List
ﬁ Bridge Locking and Unlocking
ﬁ Configuration
-~ (& Design Events
ﬁ zeneral Preferences
ﬁ Libraries
ﬁ Library Import
ﬁ Load Rating Tool
- Log Events
ﬁ Parameters
ﬁ Private Analysis Setting Template Admi
ﬁ Private Analysis Setting Templates
- (& Private Bridge Folders
ﬁ Private Folder Administration
ﬁ Public Analysis Setting Templates
ﬂ Public Bridge Folders
ﬁ Rating Events
- Systern Data Export/Import
- Systemn Defaults
ﬁ User Profile Settings
ﬁ User-Owned Library Entries
@ Parameters
= System Defaults

BRIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW |

@& Retrieve Al {3 Select All =A Us C ustumaw o
o ¥z iy

@ Retrieve Next {Z} Select None
Refresh ) Sort  Select Library Configuration
W Invert Selection By= Columns

Bridge Explorer View

avorites Folder
i Checked Qut




System Defaults X

General

Bridge workspace

Superstructure analysis | Specifications

Substructure analysis

Tolerance | Custom agency fields | Rating tool |

Load rating tool repositony:

Browse

WITDHQ1F5P08\AssetManagement\Load Rating\LR ITDM\ErR Prec

ND305AE19-0435-4585-BE4D-T022AFAFBESS-7.0.0.3001

PFTE:HQ Code Description Pass condition * i{n;;;act rg:;g;i
28 1 oK 100.00

2 2 45 mph 45 mph 69.20

3 2 25 mph 25 mph 3850

4 4 5 mph 5 mph 0.00

3 3 single lane single lane 100.00 ]

B 6 single lane, 45 mph | single lane, 43 mph 69.20 ]

7 7 single lane, 25 mph | single lane, 25 mph 38.50 ]

g 8 single lane, 5 mph | single lane, 5 mph 0.00 ]




D Load Rating Tool

Permit application number:

Application date: | 371372022

[

Requested by:

Minimum allowable rating facton:

Comment:

Bridges ] Vehicles } Rating results '\'|

Filter results: Faszs Fail Exceptions
‘ Vehicle Rﬁ;::? BID Bridge ID HED;;; Code | Description £$nf:::x ra?]pr;mf::l?:r Cc::::'__ltng Pass conditions | Analysis warnings

240k Test Truck (Do not dele... | Oper... 1740 | 15790 _o... | 00084 1 oK 0.759 1.267 1.000 —

240k Test Truck (Do not dele... | Oper... 1741 | 15795_o... | 00084 1 oK 0.803 1342 1.000

240k Test Truck (Do not dele... ' Oper... 1825 | 26220 00000 1 oK 1.645 2748 1.000

240k Test Truck (Do not dele... | Oper... 1858 | 33435 00000 1 oK 1.330 2221 1.000

240k Test Truck (Do not dele... | Oper... 1916 | 26261 00000 1 oK 1.119 1.873 1.000

240k Test Truck (Do not dele... | Oper... 1917 | 26280 00055 1 oK 0.734 1.604 1.000

240k Test Truck (Do not dele... | Oper... 1930 | 21600 07433 Denied 0.575 0.959 1.000

240k Test Truck (Do not dele... | Oper... 1930 | 21600 07433 | 2 45 mph 0.619 1.032 0.692 | 45 mph

240k Test Truck (Do not dele... | Oper... 2061 | 33415 07023 Denied 0.502 0.839 1.000

240k Test Truck (Do not dele... | Oper... 2061 | 33415 07023 Denied 0.541 0.903 0.692

240k Test Truck (Do not dele... | Oper... 2061 | 33415 07023 Denied 0.585 0.978 0.385

240k Test Truck (Do not dele... | Oper... 2061 | 33415 07023 | 4 5 mph 0.653 1.091 0.000 | 5 mph B

240k Test Truck (Do not dele... | Oper... 2063 | 34015 00016 1 oK 0.709 1.296 1.000

240k Test Truck (Do not dele... | Oper... 2125 | 21451 07553 1 oK 1.058 11.786 1.000 A

240k Test Truck (Do not dele... ' Oper... 2130 | 25866 00000 1 oK 1325 2212 1.000 1

240k Test Truck (Do not dele... | Oper... 2168 | 25876 00000 1 oK 1.339 LRy 1.000

240k Test Truck (Do not dele... | Oper... 2172 | 25836 09273 1 oK 1.408 2351 1.000 L4

240k Test Truck (Do not dele... | Oper... 2175 | 34020 00016 1 oK 0.882 1472 1.000 B
Create rating results file.., | ‘ View rating results file... |

Close

L, L L)




LoadRatingTool PermitType

Managing Data

LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LFD
LRFR
LFD
LFD
LFD
LFD
LFD
LFD MA, Check out to
LFD
LFD

-

-~ [ Com ponents
w Ciaphragm Definitions
ﬁ' Lateral Bracing Definitions

Custom agency fields

| Field | Value |

]

Permit...

A
A
A
A
A
A
A
A
A
A
A
A
A
A
A

=

DeckTy... | ConcreteComp...
Engine A

FastAct..,

LoadRa.. | Y

PermitT... | LFD

EIGHT

MNIME

TEN

- = | s

=




BERIDGE EXPLORER

| BRIDGE | FOLDER

RATE

TOOLS

AASHTOWare Bndge Design

é Import | _ "
D & ) Batch ~ @5 » » W
Mew CheckOut Find
Authonzation = oy
Bridge Manage Protection
-7 Favorites Folder Chec )
[ Recent Bridges ked S BID Bedoe 4. | Bridge Name | District | County | Facility | Location | Route | Feature Intersected
= @ All Bridges Out % v
@Al SRUNE BN mﬂﬂ—mj—m—.:mmmw e e
5. 3 Completely Defined 542 10660 086104 148 04 31 Cassi | 86 WE 28,6 E. Bu 00086 Yale Road:Raft River
@115 4107 10665 086104 18.93 05 77 Powe | 86 WE 19.6 W. A 00086 COUNTY ROAD GS
=T 2221 10675 086104 20.78 05 77 Powe 186 8 R 17.9 W Ar 00086 Lanes Gulch
- il 186 2354 10680 086104 22.44 05 77 Powe | 86 EBL 16.2 W. A 00086 Fall Creek
- [l 190 2377 10685 086104 2245 05 77 Powe | 86 WB 16.2 W. A 00086 Fall Cresk
- log LRT 1350 10690 S08610A 23.8: 05 77 Powe | 86 & F 14.8 W. A 00086 Little Warm Creek
-~ il SH 200 264 10695 086104 025.3 05 77 Powe | 86 EBL 13.2 W. A 00086 Dairy Canyon:Fronta
- sH 28 265 10700 0861042535 05 77 Powe | 86 WE 13.2 W. A 00086 Dairy Canyon:Fronta
E zﬂ ii 267 10705 086104 26.46 05 77 Powe | 86 EBL 12,1 W. A 00086 ROCK CR:MASSACR
@ US 12 1059 10710 086104 2647 05 77 Powe |-86 WE 12,1 W. A 00086 Rock Cr:Massacre Re
- @@ us 20 1423 | 10740 S08610A 32.4! 05 77 Powe | 86 & F 6.0 W. An 00086 Little Creek
- US 26 5784 | 10750 086104 034 05 77 Powe 1-86 EBL 4.6 W, An 00086 Warm Cresk Road G
- [ S 30 5785 10755 086104 034.0 05 77 Powe |-86 WE 4.6 W. An 00086 Warm Creek Road G
- [l US 91 3169 10765 086104 38.58 05 77 Powe | 86 EBL AT AMERI 00086 SUMBEAM ROAD GE
-~ Us 93 3170 10770 086104 38,59 05 77 Powe | 86 WE AT AMERI 00086 SUNBEAM ROAD Gt
""" R Us 95 6244 10775 086104 30.28 05 77 Powe 186 EBL NEAR AM 00086 PRIVATE RD:MACHI
""" B Not Completely Defined 6245 10780  08610A3929 05 77 Powe 186 WE NEAR AM 00086 PRIVATE RD;MACHI!
""" ¥ Deleted Bridges 1212 10790 026104 41.32 05 77 Powe | 86 EBL 2.7 E Ame 00086 Konp Rd GS

£l
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Managing Load Rating Tool Files / Datz

We review Load Rating Tool files monthly
 Create for new structures
« Update for changed structures
 Delete for structures no longer in inventory



M Precomputed Data

Generate Maintain \'|

‘ ‘ | Precomputed data | Bridge database
o i | B ctmrctom 11 | Pomi it | Fmm~etad by | Bridge ID | NBI structure ID | Date last modified | Last modified by | .
ge 5 ure
ler | 18670 000000000018... | 2/7/2018 Tisha Hyde [ -
v clASeileli @ ERIDGE  FOLDER | RATE | TOOLS — VIEW ler 18675 000000000018... ' 2/25/2019 Anthony Beauc... | []
- — = — 01 2 ler | 18735 000000000018... | 7/13/2017 T!sha Hyde [
= g 10 = ler 112930 | 0000000DOONZ... | 9/4/2017 Tisha Hyde O
Rate Rating Recent Rating Manage Analysis | Open | Precomputed Load Rating ler 12920 000000000012... | 2/26/2019 Anthony Beauc... O] =
Results  Results Events Data Tool ler | 120925 000000000012... | 1/17/2017 Tisha Hyde ]
Rate Results Routing Rating Tool ler | 17690 000000000017... | 7/6/2017 Tisha Hyde [
| -7 Favorites Folder \ Chec | . J L - l ler | 18300 000000000018... | 4/15/2019 Tyler Haney O
s cborh G Ol cber O | fakPidgler | 26678 000000000026... | 2/4/2018 Tisha Hyde [
11... | 29586 000000000029... | 1/19/2021 Jake Legler | 29586 000000000029... | 2/4/2018 Tisha Hyde [}
11.. | 31258 00000000003 1... | 1/19/2021 Jake Legler | 31258 000000000031... | 7/7/2017 Tisha Hyde [
11... | 10396 000000000010... | 1/19/2021 Jake Legler | 10396 000000000010... | 2/10/2018 Tisha Hyde Cl
11... | 13485 000000000013... | 1/19/2021 Jake Legler | 13485 000000000013... | 3/3/2021 Tyler Haney
11...| 11050 000000011050 | 1/19/2021 Jake Legler | 11050 000000011050 | 3/29/2019 Anthony Beauc... | ||
11...| 11055 000000011055 | 1/19/2021 Jake Legler | 11055 000000011055 | 3/29/2019 Anthony Beauc... | ||
11...| 11160 000000011160 | 1/19/2021 Jake Legler | 11160 000000011160 | 6/16/2017 Tisha Hyde [
11..[ 11185 000000000011... | 1/19/2021 Jake Legler | 11185 000000000011... | 2/25/2019 Anthony Beauc... | ||
11..[ 11190 000000000011... | 1/19/2021 Jake Legler | 11120 000000000011... | 6/25/2017 Tisha Hyde ]
11... | 15680 000000000015... | 1/19/2021 Jake Legler | 15680 000000000015... | 2/26/2019 Anthony Beauc... | ||
11... | 15805 000000000015... | 1/19/2021 Jake Legler | 15805 000000000015... | 3/9/2018 Tyler Haney [
11... | 16520 000000000016... | 1/19/2021 Jake Legler | 16520 000000000016... | 1/31/2014 Tisha Hyde ]
11... | 16525 000000000016... | 1/19/2021 Jake Legler | 16525 000000000016... | 1/31/2014 Tisha Hyde ]
11... | 16865 000000000016... | 1/19/2021 Jake Legler | 16865 000000000016... | 2/10/2018 Tisha Hyde [
11... | 16870 000000000016... | 1/19/2021 Jake Legler | 16870 000000000016... | 2/10/2018 Tisha Hyde [
11.. | 16920 000000000016... | 1/19/2021 Jake Legler | 16920 000000000016... | 2/10/2018 Tisha Hyde ]
11 16925 000000000016, | 1192021 lake |ealer 16925 000000000016 202018 Tisha Hude [ p-{
Select All | |SEIectDutdated| |Select Mot Found| | Clear Selected | |Update Selected‘ | Delete Selected

Close




i % | 8BO39TES-D46A-4253-893D-BAC2FBEABE2B-7.2.0.3001
Home Share View
» MM &om [ x _I %) New item + \,‘] feOpen - H setect al
|
Wi Copy path * L4 ] Easy access v | ! Edit | Select none
- . Pinto Quick Copy Paste Move Copy Delete Rename New Properties
o Do mputed Data access (2] Paste shoaut 4o to - folder v

Clipboard Organize New Open Select

aoristory 4 invert setection

v e » This PC » AssetManagement (\\itdops) (Y:) » Load Rating » LRITD » BrR Precomputed Data » BBO397E9-046A-4253-8930-B4C2FBEABE2B-7.2.0.3001

Generate | Maintain

& Pictures L Date modified Type Size

Analysis type: e Girder Invoice2 ! B/4/2023 1:19PM  BIN File 1314K8
. JL Check ) i 8/1/2023200PM  BIN File 162 KB

Rating method: | LFD ' POA ) i 8/1/2023 200PM  BIN File 262 K8
| Special Bridge Requirements |} 7477, 8/1/2023 1:159PM  BIN File 178 K8

Points of interest ) A 8/1/2023 1:59 PM BIN File 133K8

25 @ OneDrive ) i B/1/20231:59PM  BIN File 133K8

[_] Override bridge points of interest 98 This PC ) 7510 8/1/203 159PM  BINFile 154 K8

= [ 8/1/2023 1:59PM  BIN File 357K8
6/16/20231:51PM  BIN File 76 K8
6/16/2023 1:51PM  BIN File 86 K8
6/16/2023 1:51PM  BIN File 86 K8
4 Downloads | 7457.bi 6/16/2023 1:51PM  BIN File 92K8
D Music 0 6/16/2023 1:51PM  BIN File 87K8
[& Pictures | 7365.bi 6/16/2023 1:51PM  BIN File 23K8
B Videos ) i 5/31/2023 1:20PM  BIN File 262 KB
5/31/2023 1:20PM  BIN File 219K8
5/30/2023 1202 PM  BIN File 87K8
&8 Temp_Common (\Wedets) () 5/30/202312:02PM  BIN File 23K8
£ DESFlles (\Wkdhwy) () §/30/202312:02PM  BIN File 102 K8
% Mac_Common (\\itdops) (L) 5/30/2023 1201 PM  BIN File 2997 KB
= BridgeApps (\\itdhqlapp03) (M:) ] { 5/30/2023 8:22 AM  BIN File 151 KB
D Stop on first error o hwyfiles (\itdhwy) (N:) ] . bi §/30/2023 821 AM  BIN File 160 K8
- HQGIS (\ITDGISHQ) (07) §/22/202311:22 AM  BIN File 148 K8
Save as system defaults % Projects (\TOHQIAPP24\cadd\CaddData\HQ) (P) VIVNB1TPM.  BINFile 92K8
; 3/20/2023 1:20PM BN File 928

i o (A ong 523 3J22023804PM  BINFile 207K8

R CAU (\itdnas\Design) (R;) 322023804PM  BINFile 101 K8

“x CADD (\WTDHQIAPP24\cadd\CaddData\HQ) (5 3/2/2023 &:04PM BN File 127K8

- Projects (\\itdd0bfsp01\06) (T:) ) .bi 3/2/2023 8:04 PM BIN File 410 K8

o jlegler (\itdhqusers\users) (U:) " | 3/2/2023 803 PM BIN File 284 KB
a bridge (\itdhwy\hwyfiles) (V:) | T72bi 2/2023803PM  BIN File 212K8
a Design (\itdops\OpsFiles\DEPP\Bridge) (X) 2/2003802PM  BIN File 106 K8

3/2/2023 8:02 PM BIN File 208 KB
= AssetManagement (\\itdops) (Y:)

: ] M 3/2/2023 8:02 PM BIN File 103 K8
w BridgeApps (\\itdhqlapp03) (Z:) ) bi 3/2/2023 801 PM BIN File 1,276 KB

¥ Network | 2057.bi 3/2/2023800PM  BIN File 3,288 KB

Steel member Concrete member B 30 Objects
B Desktop
%) Documents

‘& Windows (C:)

V| Overwrite existing precomputed data




Data Updates

« Backup of BrR database
» Zip file of Load Rating Tool files
« Spreadsheet with inventory information

« Able to make emergency changes vi |

45'7%//" strictions Sy
- Can update bridge models and i ///////// |

” v, o
. | [ e [ T ; =
aa?///zp(/?%?éd, %?’/éér/’/’?
/ -

between but testing is cumben;s




Data Testing

/ e

. p |
- N\rolior
e A1 UUS /;%

* 1) 121k Test - Run the 121k Truck over all State ¢
system. Match rating method and Operating / esul

 2) 240k Test - Run the 240k Truck over all
system. Match speed and lane requiremen

//
+ 3) Side by Side (QA) - Run permits manually and make
match bridges on route, ratings, an d requirements

Y ¢
¥

24
w

atal aANIhnnanrTt
cguirerments



System Monitoring

o o /,-'z//éf
| CoUL!

are expected but system returns none. ‘

* Monitoring of Failed and Manual result for bridges that a
causing problems






Permit Process

D M permitsdidaho.com X | R

C m %) https://www.permitsdidaho.com

port favorites 4 ITD Portal - Home [j Support — AASHTO...
J Ry W E s
TRANSPORTATION DEPARTMENT

SPRING BREAK UP SEASON FREQUENTLY ASKED QUESTIONS

HELPFUL LINKS ~

Login Page

Welcome to ITRPS ITRPS User Tutorial Videos
Please login below to order permits and manage your company profile. ITRPS Customer User Guide

To create a login for a new account or user, you must contact the
permit office at 800-662-7133.

To create a new customer account with or without a USDOT you

must contact the permit office at 800-662-7133.

LOG IN TO ITRPS IMPORTANT NEWS AND ANNOUNCEMENTS

This application uses pop up windows in many functions. You can disable pop ups in your browser settings, or,

ITD Login if using Internet Explerer, you may hold down the CTRL and ALT keys at the same time when you click on a
link that results in a pop up window.

ITD PROJECTS

IDAHO ROAD CONDITIONS

DIVISIBLE LEGAL WEIGHT C

HOLIDAY NOTICE

ITD Single Sign-On (S50) Enhancement



ermit Process

1271902 ALBERTA INC

Use the form below to fill in truck and load information. Permit 1D: 366514

Vehicle

Inventory

Unit Number —, -
- - Year Make VIN Plate State

7 7

528 ~ 2 2014 » 1XKYDP9X1EJ967254 J24847
Commodity Type: ﬁ Load Description: ﬁ
Construction Equipment  +  SLUG CATCHER

| attest that the load is non-divisible. 6

[ 1 attest that hauling multiple items does create an additional over-dimension. 6

Load Parameter Load Parameter

Overall Width 6 Loaded Front o/Hang
Overall Height led Rear o/Hang

Overall Length 1 6 Loaded Weight

Enter Weights

[C] Non-Standard Gauge 6

Save and Exit Delete Permit



Permit Process

~ Set Axle Weights

Enter spacing and weight information for each axle.

Number of Axles: 8 # Tires: [ Axle width: [ Axle Type:

Total Weight: 145000 Total Spacing: 53'3"

Axle Weight Spacing (Ft.|In.) Steer

Steerable v
Non-Steerable v
Non-Steerable v
Non-Steerable v
Non-Steerable v
Non-Steerable v
Non-Steerable v

Non-Steerable v

For optimal routing, enter exact weights.
validate Weights and Close Cancel (Clears all axles.)




Questions
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